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1 | INTRODUCTION

Abstract

DectiSomes are anti-infective drug-loaded liposomes targeted to pathogenic cells
by pathogen receptors including the Dectins. We have previously used C-type lec-
tin (CTL) pathogen receptors Dectin-1, Dectin-2, and DC-SIGN to target DectiSomes
to the extracellular oligoglycans surrounding diverse pathogenic fungi and kill them.
Dectin-3 (also known as MCL, CLEC4D) is a CTL pathogen receptor whose known
cognate ligands are partly distinct from other CTLs. We expressed and purified a
truncated Dectin-3 polypeptide (DEC3) comprised of its carbohydrate recognition
domain and stalk region. We prepared amphotericin B (AmB)-loaded pegylated li-
posomes (AmB-LLs) and coated them with this isoform of Dectin-3 (DEC3-AmB-LLs),
and we prepared control liposomes coated with bovine serum albumin (BSA-AmB-
LLs). DEC3-AmB-LLs bound to the exopolysaccharide matrices of Candida albicans,
Rhizopus delemar (formerly known as R. oryzae), and Cryptococcus neoformans from
one to several orders of magnitude more strongly than untargeted AmB-LLs or BSA-
AmB-LLs. The data from our quantitative fluorescent binding assays were standard-
ized using a CellProfiler program, AreaPipe, that was developed for this purpose.
Consistent with enhanced binding, DEC3-AmB-LLs inhibited and/or killed C. albicans
and R. delemar more efficiently than control liposomes and significantly reduced the
effective dose of AmB. In conclusion, Dectin-3 targeting has the potential to advance

our goal of building pan-antifungal DectiSomes.
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three invasive fungal infections (IFls) account for more than half

of IFl-associated deaths annually (Banerjee et al., 2021; Bongomin

In 2017, it was estimated that globally, there were approximately et al., 2017; Brown et al., 2012; Low & Rotstein, 2011; Varshney

750,000 cases of candidiasis, 900,000 cases of mucormycosis, and et al., 2017). Death rates are very high even following antifungal

220,000 cases of cryptococcosis (Bongomin et al., 2017). These drug treatment, and in many cases of mucormycosis, the surgical
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removal of infected tissue is necessary. Candida albicans, Rhizopus
delemar (R. oryzae), and Cryptococcus neoformans are the most com-
mon causative pathogens, respectively, and are the test species in
the following study.

Our goal has been to design targeted pan-antifungal lipo-
somes, DectiSomes, which greatly improve the delivery and
performance of antifungal drugs. DectiSomes are defined as lipo-
somes loaded with an anti-infective drug and targeted to patho-
genic cells via a pathogen receptor protein such as a C-type lectin
(CTL). DectiSomes have several distinct advantages over more
classical antibody-targeted immunoliposomes, including a wider
range of cognate ligands, lower cost, and greater avidity (Meagher
etal., 2021, 2023). We have previously demonstrated the potential
of three CTLs, Dectin-1 (CLEC7A), Dectin-2 (CLEC6A), and DC-SIGN
(CD209), to efficiently target Amphotericin B-loaded DectiSomes
to four human fungal pathogens: C. albicans, R. delemar, C. neofor-
mans, and Aspergillus fumigatus (Ambati et al., 2022; Ambati, Ellis,
et al.,, 2019, 2021; Ambati, Ferarro, et al., 2019; Ambati, Pham,
et al., 2021; Choudhury et al., 2022; Meagher et al., 2021). One
or more of the CTL-targeted DectiSomes dramatically lowered the
effective dose of Amphotericin B (AmB) when these pathogens
were grown in vitro. DectiSomes were also shown to be effective
at reducing fungal burden and/or improving mouse survival in mu-
rine models of aspergillosis and candidiasis (Ambati et al., 2022;
Ambati, Ellis, et al., 2021; Ambati, Pham, et al., 2021).

We hoped to enhance the pan-antifungal performance of
DectiSomes by employing Dectin-3 (MCL, Macrophage C-type
Lectin, CLEC4D) (Flornes et al., 2004; Goyal et al., 2018; Wilson
et al., 2015). Dectin-3 is expressed by several lymphoid cell types,
particularly dendritic cells and macrophages. It is less well studied
than the other CTLs. Dectin-3 was initially reported to recognize
the Ascomycete Candida spp. and the Basidiomycete Cryptococcus
spp. (Goyal et al., 2018; Hole et al., 2016; Huang et al., 2018), and
shortly thereafter the Ascomycetes Paracoccidioides brasiliensis
(Preite et al., 2018) and Pneumocystis carinii (Kottom et al., 2019).
When expressed in the membrane of lymphoid cell types, dimers
of Dectin-3's extracellular carbohydrate recognition domain (CRD)
bind to fungal glycans. Then its intracellular immunoreceptor
tyrosine-based activation motif (ITAM) signals a fungal infection.
Similar to Dectin-2, Dectin-3's CRD binds yeast alpha-mannans.
Evidence for Dectin-3 recognition of a more expanded set of li-
gands comes primarily from analysis of artificial ligands (Decote-
Ricardo et al., 2019; Fonseca et al., 2009; Huang et al., 2018; Marr
et al., 2004; Martinez & Casadevall, 2007). Its potential to recog-
nize diverse novel fungal glycan and lipoglycan ligands was the
rationale for building Dectin-3-targeted DectiSomes.

We cloned and expressed a truncated isoform of murine Dec-
tin-3 containing its extracellular CRD and stalk region (DEC3) and
used it to coat Amphotericin B-loaded liposomes to make the
DectiSome DEC3-AmB-LL. We compared the ability of DEC3-
AmB-LLs to bind, inhibit, and/or kill three highly evolutionarily
divergent and morphologically distinct fungal pathogens—C. albi-
cans (Ascomycete), R. delemar (Mucormycete, Zygomycete), and C.

neoformans (Basidiomycete)—as compared to untargeted control

liposomes.
2 | RESULTS
2.1 | Preparation of Dectin-3-targeted DectiSomes

We prepared Amphotericin B-loaded pegylated liposomes (AmB-LLs)
with 11 to 12 moles percent AmB relative to 100 moles percent lipo-
somal lipid, wherein AmB is intercalated into the liposomal membrane
(Ambati, Ferarro, et al., 2019). They have a similar AmB concentration
to the analogous commercial FDA-approved un-pegylated liposomal
drug AmBisome (U.S. Food and Drug Administration, 1997). We cloned
the N-terminal portion of the sequence encoding the CRD and stalk re-
gion of murine Dectin-3, which was codon optimized for E. coli expres-
sion (hereafter referred to as truncated Dectin-3 or DEC3, Figure SF1).
For this liposomal presentation, we omitted the transmembrane and
intracellular ITAM signaling domains of Dectin-3. The E. coli-produced
DECS3 polypeptide was affinity purified (Figure SF2a,b) and coupled
to a pegylated lipid to make DEC3-PEG-DSPE. The DEC3-PEG-DSPE
polypeptide was inserted via its DSPE lipid moiety into the AmB-LLs
at 1 mole percent to make the DectiSome DEC3-AmB-LL by meth-
ods we have described previously for other DectiSomes (Ambati, Ellis,
et al., 2019; Ambati, Ferarro, et al., 2019; Ambati, Pham, et al., 2021).
The construct allows the CRD and stalk region of DEC3 to float freely in
the liposomal membrane and to form functional homodimers and mul-
timers (Meagher et al., 2021, 2023). Bovine serum albumin (BSA) was
also lipid-modified and inserted via its DSPE moiety, but at 0.3 moles
percent, accounting for its 3-fold higher molecular weight relative to
our truncated Dectin-3 polypeptide (Ambati, Ferarro, et al., 2019).
AmB-LLs and BSA-AmB-LLs served as negative, untargeted liposome
controls for non-specific binding and killing. It was assumed that the
protein coating of BSA-AmB-LLs would interfere with the untargeted
interaction of AmB-LLs with fungal cells (LaMastro et al., 2023). All
three types of liposomes were fluorescently tagged with 2 moles per-

cent Rhodamine-B-DHPE loaded into the liposomal membrane.

2.2 | Qualitative and quantitative assessment of
DectiSome binding to three fungal pathogens

C. albicans, R. delemar, and C. neoformans were grown in vitro, treated
with rhodamine B-labeled DEC3-AmB-LLs, BSA-AmB-LLs, or AmB-
LLs, washed, and then photographed using fluorescence microscopy.
Under the in vitro growth conditions used, C. albicans cells exhibited
both yeast and hyphal morphologies; R. delemar grew with a hyphal
morphology; and C. neoformans was in the yeast form. These ex-
periments allowed the qualitative assessment of liposome binding
to various fungal cells of different morphotypes. The areas of rhoda-
mine B red fluorescence were measured from multiple photographs
to quantify these binding data. We began assessing fluorescent lipo-
some binding area data by manually processing each image through



CHOUDHURY ET AL.

Wi LEYﬂ

ImageJ as done previously (Ambati, Ellis, et al., 2019; Ambati, Ferarro,
et al., 2019; Ambati, Pham, et al., 2021; Choudhury et al., 2022). To
reduce the labor involved in quantifying fluorescent liposome binding
data and standardize the process, we created a CellProfiler pipeline,

AreaPipe, that automates quantitative image analysis (Figure SF3).

2.3 | C.albicans

Dendritic cell Dectin-3 and purified epitope-tagged Dectin-3 pol-
ypeptides are reported to recognize C. albicans, at least in part,
via their binding to extracellular oligo-mannans (Goyal et al., 2018;
Wang et al., 2016; Zhu et al., 2013). Because Dectin-3's interac-
tions with C. albicans are the best characterized for any fungal
pathogen, we began our analysis of DEC3-AmB-LLs with this spe-
cies. In our first experiment, C. albicans yeast cells were grown
on microscope chamber slides for only 1.5h in hyphal growth-

inducing media, wherein they just reached the yeast-hyphal

@ DEC3-AmB-LLs

”

10 microns
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-

transition stage of development. Fixed cells were stained with
DEC3-AmB-LLs and control liposomes and viewed top-down at
high magnification (60x) using combined epifluorescence and
phase contrast microscopy (Figure 1). DEC3-AmB-LLs bound ef-
ficiently to the exopolysaccharide (EPS) matrices surrounding all
yeast-hyphal stage cells (Figure 1a), while binding by control BSA-
AmB-LLs and AmB-LLs was not detected (Figure 1b,c). Five pixels
were substituted for the zero values of liposome binding in some
control images, which was equivalent to the smallest numbers
we had detected out of the 5 x 10° total pixel area in some ex-
periments. The area of DEC3-AmB-LL binding was approximately
9,700-fold larger than for BSA-AmB-LLs or AmB-LLs (p<0.0001,
Figure 1d). The data are presented in a log,, scale scatter bar plot
to reveal the dispersion of individual data points over a large dy-
namic range that would have been obscured in a linear plot.

In our next experiment, C. albicans was grown on plastic mi-
crotiter plates until they produced mature hyphal colonies a few

hundred microns in diameter, fixed, treated with liposomes, and
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FIGURE 1 DEC3-AmB-LLs bound efficiently to Candida albicans during the yeast-hyphal transition stage of development. (a-c)
respectively, show representative photographic images of red fluorescent DEC3-AmB-LLs, BSA-AmB-LLs, and AmB-LLs binding to C.
albicans in the yeast-hyphal transition stage. After plating in media that stimulated hyphal development, yeast cells were grown for 1.5h to
reach this stage. The scale bar corresponds to 10 um. Images were acquired at 60x magnification and equivalently cropped to enlarge cells
for presentation. Composite images were prepared because the cells were widely dispersed in each 60x field. (d) The relative area of red
fluorescent liposome binding (log,,) was quantified using AreaPipe and is shown in scatter bar plots. N=10 for each bar. Standard errors

from the mean and p values are indicated.
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viewed bottom-up using combined epifluorescence and bright
field microscopy (Figure 2). DEC3-AmB-LLs bound strongly
(Figure 2a). Most of the binding appeared to be to patches of
hyphal-associated EPS at the periphery of the colonies, where hy-
phae had been growing most rapidly, and less binding was associ-
ated with older cells at the center of colonies. Control liposomes
bound rarely (Figure 2b,c). The area of DEC3-AmB-LL binding
was 1,150-fold larger (P, <0.0001) than for BSA-AmB-LLs and
43-fold larger (P, <0.0001) than for AmB-LLs (Figure 2d). We
speculate that the stronger binding of AmB-LLs relative to BSA-
AmB-LLs may be attributed to non-specific binding of the liposo-
mal membrane with hydrophobic components on the cells, such
as cellular membranes (LaMastro et al., 2023), wherein a coating
of BSA interfered with this interaction. Biological replicates of
these two experiments with C. albicans showed similar results

(Figure SF4a,b, respectively).

2.4 | R.delemar

Dectin-3 has not previously been reported to recognize Mucormy-
cetes such as R. delemar. Because R. delemar does not stick efficiently
to plastic or glass growth substrates (Ibrahim et al., 2005), we cul-
tured the cells on agar media in petri dishes, where we have shown
that they stick efficiently (Choudhury et al., 2022). Agar plugs were
removed, fixed, washed, stained with rhodamine B-labeled DEC3-
AmB-LLs, AmB-LLs, and BSA-AmB-LLs, and in some cases also with
calcofluor white (CW) for chitin, and washed extensively to remove
unbound liposomes and CW (Choudhury et al., 2022). Stained cells
were viewed top-down by epifluorescence and, in some experi-

ments, also by phase contrast.

(a) DEC3-AmB-LLs

d 1000000 -
(c) AmB-LLs ' (d) 100000
10000
1000
100+

104

(b) BSA-AmB-LLs

R. delemar cells were grown for 6 h to the germling stage or 15h
to the mature hyphal stage. We found that DEC3-AmB-LLs bound
strongly to fixed swollen sporangiospores and germ tubes of germ-
ling stage cells (Figure 3a). By contrast, binding by the control lipo-
somes was rarely observed (Figure 3b,c). DEC3-AmB-LL binding was
heavily concentrated in the EPS deposits (yellow arrows). There was
some staining that appeared to be tightly associated with the cell wall
(white arrows), but it was not possible to distinguish binding to the
cell wall itself from EPS that was closely allied with the cell wall. The
patchy nature of the staining along the cell wall may be accounted
for either by the deposition of small amounts of EPS proximal to
the cell wall or by small regions in the cell wall containing cognate
ligands of Dectin-3 that are exposed, thus enabling DEC3-AmB-LL
staining. The area of red fluorescent DEC3-AmB-LL binding was 164-
fold larger (P,,,,=0.0022) than that for BSA-AmB-LLs and 188-fold
larger (Py,,,=0.0022) than that for AmB-LLs (Figure 3d). We did not
observe preferential binding by AmB-LLs relative to BSA-AmB-LLs.

When fixed hyphal colonies of R. delemar were examined
(Figure 4), we again observed that DEC3-AmB-LLs bound to cell-
associated EPS deposits (Figure 4a), which are more obvious in a
higher magnification image (Figure 4b). Control liposomes seldom
bound (Figure 4c,d). The area of DEC3-AmB-LL binding was 614-
fold larger (P,,,, <0.0001) than for BSA-AmB-LLs and 39-fold larger
(Ppw <0.0001) than for AmB-LLs (Figure 4e). Consistent with the
data for C. albicans, the AmB-LLs showed higher levels of non-
specific binding than the BSA-AmB-LLs.

When live mature hyphal colonies were examined (Figure 5a-d),
we observed that DEC3-AmB-LLs bound to hyphal-associated EPS
deposits in a pattern similar to fixed hyphae (Figure 5a) and control
liposomes seldom bound (Figure 5b,c). The relative area of DEC3-

AmB-LL binding was less dramatic than for fixed cells. The area of

100 microns FIGURE 2 DEC3-AmB-LLs bound

efficiently to Candida albicans hyphae.
(a-c) respectively, show representative
photographic images of red fluorescent
DEC3-AmB-LLs, BSA-AmB-LLs, and
AmB-LLs binding to 15-hr-old hyphal
colonies. The scale bar indicates the

size of the hyphae photographed at 20x
magnification. (d) The relative area of red

Area Liposome Binding (pixels)

fluorescent liposome binding (log,,) was
quantified using AreaPipe and is shown
in a scatter bar plot. N=10 for each bar.
Standard errors from the mean and P,
values are indicated.
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FIGURE 3 DEC3-AmB-LLs bound
efficiently to Rhizopus delemar germlings.
(a-c), respectively, show representative
photographic images of red fluorescent »
DEC3-AmB-LLs, BSA-AmB-LLs, and AmB-
LLs binding to CW-stained germinating
sporangiospores and germling germ
tubes. Sporangiospores were germinated
on an agar surface for 6 h. The scale

bar indicates the size of the germlings
photographed at 20x magnification. The
images were cropped to show enlarged
germlings. (d) The relative area of red
fluorescent liposome binding (log, ) was
quantified using AreaPipe and is shown

in a scatter bar plot. N=46 for each bar.
Standard errors from the mean and P,
values are indicated.

DEC3-AmB-LL binding was 21-fold larger (P,,,,=0.0012) than for
BSA-AmB-LLs and 73-fold larger (P,,,,=0.0006) than for AmB-LLs.

Perhaps the dynamic nature and turnover of cognate ligand sites in

the EPS of live cells turn over DectiSome binding during the bind-
ing and washing steps, resulting in the weaker binding observed in
live cells relative to fixed cells. Biological replicates of these three
R. delemar liposome binding experiments showed similar results
(Figure SF4c-e).

2.5 | C.neoformans

Dendritic cell Dectin-3 was previously reported to recognize C.
neoformans (Goyal et al., 2018; Hole et al., 2016). Therefore, we an-
ticipated that DEC3-AmB-LLs would bind to this species. Colonies
of C. neoformans were grown on minimal agar plates for 6 or 18h.
Agar plugs were removed, fixed, washed, stained with rhodamine
B-labeled DEC3-AmB-LLs, AmB-LLs, BSA-AmB-LLs, and CW, and
washed extensively. Colonies were observed using top-down epif-

luorescence (Figure 6).

(a) DEC3-AmB-LLs
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Six-hr-old C. neoformans colonies were composed of only three
cells to two dozen cells (Figure 6). DEC3-AmB-LLs bound strongly
to the EPS matrices associated with almost every colony (Figure 6a),
even those composed of only a few cells, while binding by control
liposomes was rarely observed (Figure 6b,c). DEC3-AmB-LLs bound
to a 409-fold larger area (P,,, <0.0001) than BSA-AmB-LLs and a
155-fold larger area (P}, <0.0001) than AmB-LLs (Figure éd).

Eighteen-hr-old C. neoformans colonies were approximately 200
to 300 microns in diameter (Figure 7) and composed of thousands of
cells. DEC3-AmB-LLs bound to numerous patches both within and at
the boundary of mature colonies (Figure 7a). Some binding appeared
to be specific to the EPS matrix at the periphery of the colonies (yel-
low arrows), while the binding that completely surrounded some
small groups of cells might be specific to the cell capsules or capsule-
associated EPS of these spherical cells (white arrows). Binding by
BSA-AmB-LLs and AmB-LLs was seldom detected (Figure 7b,c), but is
indicated for AmB-LL binding by thin white arrows (Figure 7c). DEC3-
AmB-LLs bound to a 6,160-fold larger area (P,,,,, <0.0001) than BSA-
AmB-LLs and to a 4,160-fold larger area (P,,,, <0.0001) than AmB-LLs
(Figure 7d). Biological replicates of these two C. neoformans liposome
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binding experiments produced similar results (Figure SF4f,g). To con-
firm that DEC3-AmB-LLs exhibit specific binding to fungal glycans, we
tested the ability of various oligoglycans to inhibit binding to 16-hr-old
C. neoformans colonies and found modest inhibition by oligomannans
as expected and by glucuronic acid (Figure SF5) as recently reported in
an independent study (Huang et al., 2018). The inhibition by laminarin
shown in this experiment was unexpected and inconsistent among ex-
perimental replicates. Importantly, neither DEC3-AmB-LLs nor control
liposomes BSA-AmB-LLs and AmB-LLs bound detectably to human
HEK293T cells, as shown in Figure SFé6.

2.6 | Binding by Dectin-3 protein

The exterior portion of the cell wall of C. albicans is rich in vari-
ously crosslinked oligomannans and mannoproteins (Garcia-Rubio
et al., 2020; Gow et al., 2017; Schiavone et al., 2014). The cell walls

of Mucorales species contain small amounts of variously crosslinked

(b) DEC3-AmB-LLs

FIGURE 4 DEC3-AmB-LLs bound
efficiently to fixed Rhizopus delemar
hyphae. (a-d) respectively, show
representative photographic images of red
fluorescent DEC3-AmB-LLs, BSA-AmB-
LLs, and AmB-LLs binding to CW-stained
15-hr-old hyphae grown on an agar
surface photographed at 10x, and (b)
shows DEC3-AmB-LLs photographed at
20x magnification. The scale bars indicate
the size of the hyphae photographed at
10x (a, ¢, and d) or 20x magnification (b).
(d) The relative area of red fluorescent
liposome binding at 10X (log, ) was
quantified using AreaPipe and is shown

in a scatter bar plot. N=9 for each bar.
Standard errors from the mean and P,
values are indicated.

100 microns
I

mannans (Lecointe et al., 2019). The exterior portion of the C. neofor-
mans capsule is rich in glucuronoxylomannans (GXMs), which are a
known ligand of Dectin-3 (Garcia-Rubio et al., 2020, Gow et al., 2017).
Therefore, we expected Dectin-3-targeted liposomes to bind to the
cell wall or capsule of all three species. Yet, we did not observe DEC3-
AmB-LLs to be unambiguously bound to their cell walls or capsules.
We considered the possibility that the 100-nanometer diameter of
DEC3-AmB-LLs was simply too large to physically access the cognate
ligands of Dectin-3 within the highly crosslinked glycan matrices of
the cell walls and/or capsules. We estimate the rotational diameter of
the 23kDaMW truncated Dectin-3 polypeptide (DEC3) to be only a
few nanometers. To test this hypothesis of size limitation for liposome
binding, we directly conjugated rhodamine B (MW 0.48kDa) to the
Dectin-3 polypeptide to make DEC3-Rhod. DEC3-Rhod bound to the
EPS matrices surrounding the various developmental stages of all three
species and has comparable spatial distributions to those of DEC3-
AmB-LLs (Figure SF7a-e). The localization of both DEC3-AmB-LLs and
DEC3-Rhod staining varied widely from C. albicans colony to colony, as
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FIGURE 5 DEC3-AmB-LLs bound
efficiently to live Rhizopus delemar hyphae.
(a-c) respectively, show representative
photographic images of red fluorescent
DEC3-AmB-LLs, BSA-AmB-LLs, and AmB-
LLs binding to live CW-stained hyphae.
The scale bar indicates the size of the
hyphae, which were photographed at 10x
magnification. (d) The relative area of red
fluorescent liposome binding (log,,) was
quantified using AreaPipe and is shown

in a scatter bar plot. N=7 for each bar.
Standard errors from the mean and P,
values are indicated.

200 microns

revealed by the distribution of data points in scatter bar plots, but no
significant difference in binding was observed between the two rea-
gents. As with the liposomal reagents, the DEC3-Rhod protein reagent
did not exhibit clear, unambiguous binding to the cell walls or capsules.
Thus, the binding pattern of DEC3-AmB-LLs does not appear to have

been dramatically altered by the physical size of liposomes.

2.7 | Quantitative assessment of the
inhibition and/or killing of three fungal pathogens

C. albicans, R. delemar, and C. neoformans were grown in vitro and
treated with the DEC3-AmB-LLs, BSA-AmB-LLs, and AmB-LLs using
different temporal regimens, after which growth, viability, and/or

metabolic activity were quantified.

2.8 | C.albicans

An overnight culture of C. albicans yeast cells was suspended into
RPMI +10% FBS hyphal-inducing media and aliquoted into 96-well
microtiter plates. Shortly after hyphal development was initiated
(1.5h, 37°C; see morphology in Figure 1), cells were treated with the
DEC3-AmB-LLs, BSA-AmB-LLs, or AmB-LLs at the indicated AmB
concentrations. Seventeen hours later, residual metabolic activity was
measured using the CellTiter-Blue (CTB) reagent (resazurin). Only live
cells with an intact plasma membrane and a functional mitochondrial
electron transport chain can reduce resazurin to the fluorescent prod-

uct resorufin. The plate was incubated for approximately 60min at

(a) DEC3-AmB-LLs

(c) AmB-LLs
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37°C, and the pink fluorescence of resorufin was quantified. The data
are presented in a log,, scatter bar plot in Figure 8a. Cells receiving
DEC3-AmB-LLs delivering 0.3, 0.2, and 0.1 uM AmB showed respec-
tively, 24-fold (P,,,, =0.0003), 127-fold (P,,, =0.0002), and 25-fold
(Pyw=0.0002) lower metabolic activity than the corresponding
BSA-AmB-LL-treated controls. Statistically significant reductions in
metabolic activity were also observed relative to the AmB-LL-treated
controls. Control liposomes delivering 0.3 ptM AmB began to have
strong inhibitory activity, thus limiting the resolution of differences at
this and higher concentrations of AmB. A biological replicate produced
similar results (Figure SF8a).

2.9 | R.delemar

R. delemar sporangiospores were plated in RPMI +0.165M MOPS
(pH7) media in 96-well microtiter plates. DEC3-AmB-LLs, BSA-
AmB-LLs, and AmB-LLs delivering different concentrations of
AmB were immediately added to the respective wells, and the
plates were incubated for 24h at 37°C with shaking at 120rpm.
Cell density was measured as O.D. at A, . Cells receiving DEC3-
AmB-LLs delivering 0.8, 0.4, and 0.2 ptM AmB were 10.8-fold
(p=5.5x107%), 7.8-fold (p=2 x 107 and 1.4-fold (p=0.024) less
dense than the respective BSA-AmB-LL-treated controls, and the
0.8 and 0.4 pM samples were similarly less dense than the respec-
tive AmB-LL-treated controls (Figure 8b). After the cell density
measurements were taken, CTB reagent was added to each well,
and the plate was incubated at 37°C for an additional two hours.
The pink fluorescence in each well was quantified. Cells receiving
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FIGURE 6 DEC3-AmB-LLs bound efficiently to the EPS matrices of small Cryptococcus neoformans colonies. (a-c) respectively, show
representative photographic images of red fluorescent DEC3-AmB-LLs, BSA-AmB-LLs, and AmB-LLs binding to CW-stained 6-hr-old
colonies of C. neoformans grown on an agar surface. The scale bar indicates the size of the colonies photographed at 20x magnification. (d)
The relative area of red fluorescent liposome binding (log,,) was quantified using AreaPipe and is shown in a scatter bar plot. N=14 for each

bar. Standard errors from the mean and P,,,, values are indicated.

DEC3-AmB-LLs delivering 1.6, 0.8, 0.4, and 0.2 pyM AmB had
28-fold (p=1.7 x107%), 105-fold (p=5.1 x107), 19-fold (p=2.9
x10™1), and 1.79-fold (Pyw=0.0079) lower metabolic activity
than the respective BSA-AmB-LL-treated cells (Figure 8c). DEC3-
AmB-LLs-treated cells had similarly reduced levels of metabolic
activity relative to the AmB-LL-treated controls. Biological repli-
cates produced comparable results (Figure SF8b,c).

2.10 | C.neoformans

C. neoformans yeast cells grown overnight in YPD were plated

at 10,000 cells per well in 96-well microtiter plates in RPMI +

0.165M MOPS (pH7) at 30°C. After a few hours of incubation
in YPD, when the cells had formed small colonies equivalent to
those shown in Figure 6, they were treated with liposomes deliv-
ering the indicated concentrations of AmB, and the plates were
incubated for 1 h at 30°C with shaking at 50rpm. The media with
unbound liposomes was removed, CTB reagent in RPMI + MOPS
media was added to each well, and the plate was incubated for an
extended period at 30°C. Cells receiving DEC3-AmB-LLs deliver-
ing 2.0 and 1.0 pM AmB showed only 1.32-fold (P,,,,=0.0002)
and 1.26-fold (PMW:O.OOOZ) lower metabolic activity than the
respective BSA-AmB-LL-treated controls (Figure 8d). There were
similar small reductions in CTB activity relative to the AmB-LL-
treated controls. Because there was small variability in the results
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FIGURE 7 DEC3-AmB-LLs bound efficiently to large Cryptococcus neoformans colonies. (a-c) respectively, show representative
photographic images of red fluorescent DEC3-AmB-LLs, BSA-AmB-LLs, and AmB-LLs binding to CW-stained 18-hr-old colonies of C.
neoformans grown on an agar surface. Yellow arrows indicate DEC3-AmB-LL binding to EPS deposits, and large white arrows indicate binding
that surrounds spherical yeast cells within the colonies. The scale bar indicates the size of the colonies photographed at 20x magnification.
The uncommon red fluorescence of control liposome binding (white thin arrows in c) had to be greatly enhanced relative to that for DEC3-
AmB-LLs to make it visible for presentation. (d) The relative area of red fluorescent liposome binding (log,,) was quantified using AreaPipe
and is shown in a scatter bar plot. N=11 for each bar. Standard errors from the mean and P,,,, values are indicated.

among eight individual samples, these results were highly statisti-
cally significant, but the fold improvements in inhibition by DEC3-
AmB-LLs were clearly marginal. A biological replicate produced
similar results for the comparison at 2.0 yM AmB but not for 1.0
or 0.5 pM (Figure SF8d). Variations in this CTB assay design, such
as longer drug treatments or not removing unbound liposomes, did
not improve the relative efficacy of DEC3-AmB-LLs. Attempts to
measure the efficacy of DEC3-AmB-LLs at reducing cell viability
by measuring reductions in cell density in microtiter plate assays,
or reductions in CFUs in liquid suspension cultures, or increases in

propidium iodide staining of dead cells all failed to give significant

results. Apparently, these techniques were not sensitive or re-
producible enough to detect the small changes in cell viability re-

vealed by CTB assays.

3 | DISCUSSION

We have shown that Dectin-3's CRD targets DEC3-AmB-LLs specifi-
cally and efficiently to the yeast-hyphal transition stage and mature
hyphal stage of the Ascomycete C. albicans, to the germling and ma-
ture hyphal stages of the Mucormycete R. delemar, and to small and
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large colonies of the Basidiomycete C. neoformans. We've added R.
delemar to the list of fungal species recognized by Dectin-3's CRD
and suggest the possibility that there are other target pathogens
for Dectin-3 yet to be discovered. These three fungal pathogens
diverged from common ancestral species several hundred million
years ago and, hence, represent some of the extreme ancient di-
versity within the fungal kingdom (Kuramae et al., 2006; Spatafora
et al., 2017; Taylor & Berbee, 2006). Fluorescent DectiSomes have
tremendous power as probes for the novel binding of CTLs, such as
Dectin-3, because each liposome has a few thousand rhodamine B
molecules and each has more than a thousand DEC3 molecules, thus
creating avidity for target ligands. DEC3-AmB-LLs bound to the EPS
matrices of these species, and there was little, if any, binding to their
cell walls and/or capsules. The much smaller DEC3-Rhod protein re-
agent also did not bind unambiguously to cell walls and/or capsules.
Fungal pathogens are thought to produce EPS to adhere to host tis-
sues and protect themselves from host immune defenses. EPS shed
into host serum could decoy immune responses away from fungal
cells. Dectin-3 may have evolved its ability to bind to the EPS as-
sociated with and shed from diverse pathogens in order to aid in the
complex host innate immune responses to infection. Our results pre-
sented here on Dectin-3-targeted DectiSomes binding to and killing
C. albicans and R. delemar compare reasonably well with our previous
publications on Dectin-1-, Dectin-2-, and DC-SIGN-targeted Decti-
Somes (Meagher et al., 2023).

Many CTLs form homodimers that form their glycan Ii-
gand binding sites at the junction of the two CRDs (Cummings &
McEver, 2022). In our previous studies, we constructed liposomes
containing the truncated forms of Dectin-1, Dectin-2, and DC-SIGN
alone, as we have done here with truncated Dectin-3. In each case,
this resulted in the efficient targeting of antifungal liposomes to fun-
gal pathogens, and this design must have enabled homodimers to
form functional ligand binding sites. Each showed dramatically im-
proved antifungal efficacy over untargeted liposomal AmB toward
one or more fungal pathogens, including Aspergillus fumigatus, C.
albicans, C. neoformans, and R. delemar grown in vitro (Ambati, Ellis,
et al., 2019; Ambati, Ferarro, et al., 2019; Ambati, Pham, et al., 2021;
Choudhury et al., 2022) and A. fumigatus and C. albicans in mouse
models of pulmonary aspergillosis and invasive candidiasis (Ambati
et al., 2022; Ambati, Ellis, et al., 2021). However, these and several
other CTLs are co-expressed in mammalian dendritic cells and mac-
rophages (Ariizumi et al., 2000; Hole et al., 2016; Kitai et al., 2021;
Sun et al., 2013; Yoshikawa et al., 2021; Zhu et al., 2013) and hence
have the potential to act cooperatively to enhance signaling. Dec-

tin-2 and Dectin-3 appear to be on the same membrane rafts in bone

marrow-derived macrophages or when co-transfected into mono-
cyte/macrophage-like RAW264.7 cells. This view of their linked be-
havior stems from results showing that when either binds a cognate
ligand or is treated with either Dectin-specific antibody, the two
CTLs are co-endocytosed (Zhu et al., 2013). The study used bimolec-
ular fluorescence complementation of Dectin-2 and Dectin-3 yellow
fluorescent protein fusions in HEK293 cells to show that the co-
expressed proteins physically interact on cell surfaces to form het-
erodimers that have enhanced and perhaps novel ligand binding and
signaling properties. The implication is that physically connected
heteromeric CRDs of the two CTLs are formed and have novel
properties of ligand recognition. By contrast, when co-transfected
into embryonic kidney 293 T cells, Dectin-2 did not appear to form
heteromeric complexes with Dectin-3 (Blankson et al., 2022). Thus,
it is possible that other factors are required for their linked behav-
ior. Now that we have shown that Dectin-3 functions efficiently
when floating on a liposomal surface, we can construct liposomes
co-presenting Dectin-3 and Dectin-2 and test their interaction in a
cell-free system. If liposomal co-presentation of Dectin-2/Dectin-3
enhances and expands their ligand binding properties, this should
make a more effective pan-antifungal delivery vehicle than either
Dectin alone.

The superfamily of CTL genes contains more than 30 members
and several subgroups based on the sequences of their CRDs and
their functional structures and signaling domains when positioned
in the cell membrane (Drickamer & Taylor, 2015). Among the fif-
teen members of structural group 2 CTLs, Dectin-3, Dectin-2,
and DCSIGN (CD209) all recognize oligomannans. This is a well-
represented class of glycans that form part of the cell walls and
EPS matrices of most fungal pathogens (Briard et al., 2021; Drick-
amer & Taylor, 2015; Gow et al., 2017; Goyal et al., 2018). However,
our previous studies showed that Dectin-2- and DCSIGN-targeted
liposomes stained fungal EPS matrices with little, if any, staining
of fungal cell walls or capsules (Ambati, Ellis, et al., 2019; Ambati,
Pham, et al., 2021; Meagher et al., 2023). In these previous studies,
as herein, microscope observations showed that binding was pri-
marily localized to the material closely associated with the cells, but
there was minimal binding tightly associated with the cell wall. We
have inferred that this material is EPS, which is also known to con-
tain cognate ligands of various CTLs. At the outset, we suspected
that Dectin-3 would recognize distinct fungal oligoglycans in both
cell walls and EPS matrices and recognize diverse fungal patho-
gens. First, Dectin-3 has a relatively distinct and divergent CRD
amino acid sequence when compared to the other two Dectins.

Second, lymphoid cell Dectin-3 recognizes glucuronoxylomannan

FIGURE 8 DEC3-AmB-LLs were efficient at inhibiting and/or killing two of the three fungal pathogens examined. Candida albicans,
Rhizopus delemar, and Cryptococcus neoformans were grown in 96-well microtiter plates and treated with DEC3-AmB-LLs, AmB-LLs, and
BSA-AmB-LLs, delivering the indicated micromolar concentrations of AmB. Growth inhibition and/or killing were assayed as reductions in
cell density measured at A, or reductions in viable cell metabolic activity by measuring the electrochemical reduction of the redox dye
resazurin in CellTiter-Blue reagent to fluorescent resorufin after liposome treatment. (a) Residual metabolic activity of C. albicans. (b) Cell
density of R. delemar. (c) Residual metabolic activity of R. delemar. (d) Residual metabolic activity of C. neoformans. Cell density and metabolic
activity are shown in scatter bar plots. N=5 to 8 for each bar. Standard errors from the mean and p or P, values are indicated.
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(GXM), which is characterized as a major glycan component of C. compound. It is composed of a heterogenous mixture of poly-
neoformans capsules and a lesser component of their biofilms (Al- saccharides that vary widely in their molecular weight from less
buquerque et al., 2014; Huang et al., 2018). GXM is not a single than 10kDa to 300kDa (Albuquerque et al., 2014) and are often
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crosslinked to other glycans, thus generating different GXM vari-
ants. We previously stained in vitro-grown C. neoformans cells
with the best-characterized anti-GXM antibody 18B7 and found
robust staining of GXM within the capsule of most, but not all,
individual cells and the EPS matrix associated with some cells
(Ambati, Ellis, et al., 2019). Dectin-2 liposomal staining only par-
tially overlapped with that of the GXM antibody. Using a variety
of monoclonal antibodies to GXM, including 18B7, it was shown
that GXM encompasses many different immuno-epitopes that are
heterogeneously distributed in the C. neoformans capsule and EPS
(Albuquerque et al., 2014). Because Dectin-3 is reported to spe-
cifically recognize GXM, and GXM is a major glycan component of
C. neoformans, we anticipated the potential for highly preferential
binding to C. neoformans, and in particular its capsule, over binding
to our other two test species. But instead, we only observed stain-
ing of the EPS matrix in small colonies and sporadic staining of the
EPS surrounding some cells in older colonies. While it is possible
that our DEC3-AmB-LL reagent recognized a very small subset of
C. neoformans GXMs in the cell capsule, proving this would require
extensive immunochemical and/or biochemical analyses. It is also
possible that lymphoid cell Dectin-3 recognition of GXM requires
cooperation with other CTLs, and Dectin-3 itself does not itself
bind GXM. Our study does not attempt to identify the particular
glycans or glycolipids recognized by Dectin-3, and our results do
suggest there is still much to be learned about Dectin-3's range of
cognate ligands.

Based on the two to three orders of magnitude higher levels of
DEC3-AmB-LL binding to C. albicans, R. delemar, and C. neoformans
relative to control liposome binding, we anticipated orders of mag-
nitude more efficient inhibition and/or killing of all three species.
When delivering the low concentrations of AmB of 0.1-1.6 uM, we
showed that DEC3-AmB-LLs reduced the viable cell metabolic ac-
tivity of C. albicans and R. delemar one to two orders of magnitude
more efficiently than untargeted AmB-loaded liposomal controls.
Under the conditions of our assays, DEC3-AmB-LLs lowered the ef-
fective dose of liposomal AmB for inhibition and/or killing of these
two species by at least two orders of magnitude. By contrast, and
based on various assays, DEC3-AmB-LLs were much less effective
at inhibiting or killing C. neoformans. This was unexpected based on
DEC3-AmB-LL's efficient binding to this species. We cannot explain
the lack of strong antifungal efficacy against C. neoformans.

As to the mechanism by which AmB-loaded DectiSomes, and
DEC3-AmB-LLs in particular, increase inhibition and killing of fungal
pathogens relative to untargeted control liposomes, AmB-LLs, our
analog of AmBisome®, we propose the following. While it is known
that AmBisome® liposomes pass through the cell wall and plasma
membrane (Walker et al., 2018), it is reasonable to assume this trans-
port process is relatively inefficient because the 60 to 90 nanometer
diameter size of liposomes should impede movement through the
cell wall and membrane. While a small fraction of the untargeted
liposomes will make it through the cell wall and plasma membrane,
most will diffuse far away from the cells or be washed away, and the
AmB from these liposomes will be at much lower concentrations. By

contrast, when AmB-loaded DectiSomes are bound to the EPS, their
close proximity to fungal cells increases the concentration of AmB
diffusing from DectiSomes to fungal cells. The dimensions of AmB
are measured in 10's of Angstroms, and it is known to penetrate into
the cell membrane. The argument that AmB from DectiSomes will
diffuse more rapidly to fungal cells than untargeted liposomal AmB
is based on the Fokker-Planck equation showing that the rate of dif-
fusion proceeds as the inverse square of the distance (Fokker, 1914;
Planck, 1917). In the case of DectiSomes bound to the ligands in
the EPS proximal to the fungal cells, there should be a more rapid
and efficient diffusion of AmB to cells than by most of the untar-
geted liposomal AmB, which is more distant from fungal cells, and
the rate of diffusion to fungal cells will be much slower. Additionally,
the fact that various DectiSomes bind primarily to the EPS offers
a big advantage to their antifungal activity. Depending upon their
glycan compositions, the sheer size of the EPS should generate more
available cognate ligand binding sites than the cell wall. Hence, EPS-
bound DectiSomes should provide a larger reservoir of AmB than if
they were bound only to the cell wall.

While the goal is to develop DectiSomes as powerful pan-
antifungal therapeutics, this and our other recent studies leave
many important issues unresolved (Meagher et al., 2023). We have
only just begun to test DectiSomes in mouse models of invasive
fungal disease (Ambati et al., 2022; Ambati, Ellis, et al., 2021; Am-
bati, Pham, et al., 2021). Extrapolating from in vitro binding and
killing to in vivo studies is complicated by the fact that the glycan
and lipoglycan ligands produced by fungi are dependent upon their
growth environment. Dectins such as Dectin-3 have the advan-
tage over antibody-targeted reagents in that a unique host Dectin
sequence should have low immunogenicity relative to variable an-
tibody sequences that often produce host-specific immunogenic
responses. However, Dectin-1 and Dectin-3 recognize endogenous
ligands that discriminate self from non-self (Mori et al., 2017; Saijo
& lwakura, 2011), and as more is known about Dectin-3, it may also
be shown to recognize host ligands. Thus, there is the potential that
CTL-targeted reagents could have toxicity issues. Our ongoing re-
search explores a wide variety of topics concerning the efficacy of

DectiSomes as drug delivery agents.

4 | CONCLUSIONS

We presented statistically well-supported data showing that
Dectin-3-coated AmB-loaded liposomes, DEC3-AmB-LLs, were an
order of magnitude or more effective at binding to C. albicans, R.
delemar, and C. neoformans than either of our control liposomes,
AmB-LLs and BSA-AmB-LLs. DEC3-AmB-LLs bound primarily
to their EPS matrices and not to their cell walls or cell capsules.
DEC3-AmB-LLs were similarly effective at inhibiting or killing C.
albicans and R. delemar, but much less effective against C. neofor-
mans. Our positive data showing the inhibition of hyphal stages of
two highly divergent pathogens suggest that it would be worth-
while to explore the efficacy of DEC3-AmB-LLs in mouse models
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of candidiasis and mucormycosis and investigate the potential of
Dectin-3 to act synergistically and perhaps form heterodimers
with Dectin-2 on the same liposomes. The CellProfiler pipeline Ar-
eaPipe was introduced to automate and simplify the capture and
quantification of fluorescent area data within TIFF or JPEG im-
ages, replacing the tedious, time-consuming manual processing of

area data in Imagel.

5 | EXPERIMENTAL PROCEDURES

5.1 | Fungal strains and growth conditions

C. albicans strain SC5314 (Gillum et al., 1984) was grown in YPD
(1% yeast extract, 2% peptone, 2% dextrose, ThermoFisher
Cat#212750, #21677, Fisher Sci. Cat#D16-10, respectively) liquid
culture starting from a single colony on an agar plate and grown
at 37°C overnight with vigorous shaking. Yeast cells were washed
once into RPMI lacking phenol red dye (Sigma-Aldrich, Cat#
R8755)+10% Fetal Bovine Serum (FBS) (GIBCO Cat#10437-028)
adjusted to pH 7.5, plated at 20,000 cells/well in 1 mL and 35,000
cells/per well in 0.1 mL, and grown at 37°C to the germling or hy-
phal stage in wells of plastic 24-well or 96-well polystyrene mi-
crotiter plates or on poly-L-lysine-coated glass microscope slides
inside a glass chamber. When indicated, cells were fixed in 3.7%
formalin (J.T. Baker, #2106-01) diluted in PBS for 1 h and washed
three times in PBS before staining. The design of the reusable
glass chambers and assembled chamber slides for growing cells is
shown in Figure SF%a,b.

Sporangiospore stocks of R. delemar strain 99-880 (f.k.a. R.
oryzae and R. arrhizus, ATCC MYA-4621) were prepared as de-
scribed recently (Choudhury et al.,, 2022) and stored at 4°C,
where they remained greater than 90% viable for more than a
month. Sporangiospores were germinated and grown to germling
or hyphal stages on 1.5% agar plates made with RPMI +0.165M
MOPS (3-(N-morpholino) propane sulfonic acid; Sigma-Aldrich,
Cat# M1254) (Andrianaki et al., 2018) adjusted to pH7 and incu-
bated at 37°C (Choudhury et al., 2022). Agar plugs were removed
and processed for top-down microscopic imaging (Choudhury
et al., 2022). For quantitative inhibition and killing experiments,
cells were grown in liquid RPMI + MOPS media diluted to 800 cells
per 90 pL per well in 96-well microtiter plates. Because R. delemar
does not stick well to microtiter plates but does stick efficiently to
micropipette tips, reagents were added but never removed during
growth and inhibition assays.

C. neoformans clinical isolate H99-alpha (Montone, 2009) was
grown at 30°C in liquid YPD (1% yeast extract, 2% peptone, 2% dex-
trose) with vigorous shaking overnight. Cells prepared for micros-
copy were then plated on RPMI + MOPS agar plates and incubated
at 30°C, and agar plugs were later removed. Cells for viability assays
were plated at 10,000 cells per 90 pL per well in YPD in 96-well
microtiter plates, grown for 4.5h, and treated with liposomes, after
which the media was removed and replaced with RPMI + MOPS

media containing CTB reagent at the manufacturer's recommended

concentration.

5.2 | Production of Dectin-3

Annotated Dectin-3-derived DNA and protein sequences are
given in Figure SF1. The 219 amino acid (a.a.)-long sequence of the
native murine Dectin-3 protein (NP_034949.3) was obtained from
the National Center for Biotechnology Information (Figure SF1a).
The sequence of the E. coli codon-optimized construct of murine
Dectin-3 CRD and stalk region truncated and modified for cloning
into pET-45B and lipidation is shown in Figure SF1b and was de-
posited at the U.S. National Center for Biotechnology Information
(BankIT, HK-DEC3; accession number OQ366170). The sequence
encodes a 199 a.a.-long modified truncated Dectin-3 polypep-
tide, DECS3, beginning at its N-terminus with a vector-encoded
N-terminal (His), affinity tag, an added flexible GlySerGly spacer,
two lysine (K) residues, and another flexible GlySerGly spacer,
followed by the 176 a.a.-long N-terminal end of murine Dectin-3
(Figure SF1c). The E. coli strain BL21 containing the murine Dectin-
3-pET45B plasmid was grown in 1L of Luria broth at 37°C over-
night without IPTG induction (Figure SF2) or with IPTG induction
at 0.D. 0.7 A, followed by 4 more hours of growth. DEC3 was
extracted from cell pellets using a 6 M guanidine hydrochloride
(GuHCI) buffer and purified on nickel affinity resin in this buffer as
described previously (Ambati, Ellis, et al., 2019; Ambati, Ferarro,
et al., 2019). After affinity purification, the protein was approxi-
mately 80% pure (Figure SF2b). In various preparations, five to ten
milligrams of affinity-purified protein were typically recovered per
liter of Luria broth culture.

5.3 | Production of Dectin-3-coated drug-loaded
liposomes (DEC3-AmB-LLs)

AmB-loaded liposomes, AmB-LLs, were prepared as described pre-
viously, except that the drug loading was performed at 37°C instead
of 60°C (Ambati, Ferarro, et al., 2019). Samples of Dectin-3 were
coupled to DSPE-PEG-3400-NHS (Nanosoft Polymers, 1544-3400)
in the same 6 M GuHCI buffer with the pH adjusted to 8.3 with
triethanolamine and purified over Bio-Gel P-6 acrylamide molecu-
lar exclusion resin in a 1M Arginine crowding buffer pH adjusted to
7.3 (Bio-Rad Cat#150-0740) as we described previously for other
CTLs (Ambati, Ellis, et al., 2019; Ambati, Ferarro, et al., 2019; Am-
bati, Pham, et al., 2021). DSPE-PEG-BSA was prepared from BSA
(Sigma, Cat#A-8022) by the same protocol, except that the coupling
to DSPE-PEG-NHS was performed in 0.1 M pH 8.3 carbonate buffer,
and it was subsequently desalted by P-6 gel exclusion chromatog-
raphy in 0.1M sodium phosphate buffered saline pH7.4 (Corning,
Cat#21-031-CV). Modified Dectin-3 and BSA were loaded into
AmB-LLs at 1 and 0.33 moles percent, respectively, relative to moles
of liposomal lipid via their DSPE lipid moiety as described previously
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(Ambati, Ellis, et al., 2019, Ambati, Ferarro, et al., 2019). Typical
preparations produced 800 pL of protein-coated liposomes with
1.1 mg of modified Dectin-3 or BSA (~1.4mg/mL) and AmB at 750
uM (0.69 mg/mL). For each new batch of AmB-loaded liposomes, the
volumes of DEC3-AmB-LLs, BSA-AmB-LLs, and AmB-LLs were ad-
justed to have the same concentration of AmB, typically 750 uM, to

simplify dilutions of the three samples in subsequent experiments.

5.4 | Liposome dilutions for binding and
inhibition studies

For all liposome-binding experiments, DEC3-AmB-LLs were diluted
such that the Dectin-3 protein was at a concentration of 1 pg/100
pL (1:100w/v) in respective growth media. AmB-LLs and BSA-AmB-
LLs were diluted equivalently. For binding inhibition experiments,
DEC3-AmB-LLs (1:100w/v) were preincubated for 30 min with the
following oligoglycans at a concentration of 10mg/mL: yeast man-
nans extracted via alkaline extraction (Sigma Cat# M7504) or deter-
gent extraction (Sigma Cat# M3640), laminarin (Sigma Cat# L9634),
glucuronic acid (Sigma Cat# G5269), or the liposome dilution buffer
as a control. The oligoglycan/DectiSome mixes were then added to
pre-blocked C. neoformans plugs. For killing studies, liposomes were
diluted into growth media just before use, such that they delivered
AmB final concentrations of 0.1 to 2 pM.

5.5 | Liposome binding to a human cell line

The human embryonic kidney epithelial cell line HEK293T was
obtained from the American Type Culture Collection (ATCC #CRL-
3216). Cells were grown on 24-well plastic microtiter plates in RPMI
media plus 10% fetal bovine serum at 37°C with 5% CO,. Cells were
washed with PBS, fixed for 30min with 4% freshly prepared for-
malin, and washed thrice more with PBS. Cells were stained with
rhodamine-tagged DEC3-AmB-LLs, BSA-AmB-LLs, and AmB-LLs as
described for staining fungal cells. Images were taken bottom up on
an inverted revolving microscope at 10x magnification, combining

the visible light channel and the fluorescent Texas Red channel.

5.6 | CellProfiler analysis of fluorescent
liposome staining

All microscopy was performed on an ECHO Revolve microscope
(model #RVSF1000/Revolve R4). Red fluorescent liposome staining
was captured in the TRITC channel, CW chitin staining in the DAPI
channel, visible light images using the Ph1 phase condenser, and com-
bined images as Revolve's zoverlay.jpg files. As we began this project,
we manually captured the area of fluorescent staining image by image
in ImagelJ. The direct output from Image) presents fluorescence as a
fraction of the image area, as we presented in our previous publications
of DectiSomes and as shown in several supplemental figures herein

(SF4AC through SF4G). A CellProfiler (v4.2.4)-based pipeline, AreaPipe
(v. 5), was developed to analyze photographic images (e.g., jpg, tiff) for
the area of fluorescent reagent binding (e.g., fluorescent liposomes)
to cells (Carpenter et al., 2006). AreaPipe (AreaPipe_V5.cppipe) was
deposited at the CellProfiler repository of published pipelines at the
Broad Institute (https://cellprofiler.org/published-pipelines). In short,
the program eliminated the manual quantification of fluorescent im-
aging data. Figure SF3 shows the original rhodamine red fluorescent
jpeg image of DEC3-AmB-LLs binding to a C. albicans hyphal colony
(Figure SF3a) and compares the areas of fluorescence captured from
the image using the manual analysis method in ImageJ (Figure SF3b) as
done previously (Ambati et al., 2022; Ambati, Ellis, et al., 2019, 2021;
Ambati, Ferarro, et al., 2019; Ambati, Pham, et al., 2021; Choudhury
et al., 2022) to that obtained using AreaPipe (Figure SF3c). When using
the manual method, each red fluorescent image (e.g., Figure SF3a) jpeg
or tiff was (1) loaded into ImageJ, (2) converted to an 8-bit black and
white image under Image > Type, and (3) adjusted using threshold
settings to capture the appropriate red liposome binding area under
Image > Adjust > Threshold (30/255)> Apply. (4) These data were
placed in a file using the Analyze>Measure functions, and (5) the Im-
age) data were copied and pasted into an Excel file for subsequent
quantitative analysis. To use AreaPipe, (1) CellProfiler was opened,
(2) the jpeg or tiff images to be analyzed were pasted into the indi-
cated window, (3) AreaPipe (AreaPipe_V5.cppipe) was dragged into
the indicated window, and the operator answered “yes” to “load pipe-
line?”; (5) two separate folders were designated for the output data
files “Savelmages” and “ExportToSpreadsheet”; (6) Analyze Images was
selected; and (7) the quantitative area output data was automatically
loaded into a .csv file and the jpeg images of the segmented areas into
a folder (e.g., Figure SF3c). Some effort was devoted to ensuring that
AreaPipe accurately captured even trace images with only a few pixels
of liposomal fluorescence or could report zero pixels of fluorescence,
which was not uncommon among images of control liposome-treated
samples. Typically, AreaPipe processed 30 jpeg images in 3min using a
standard laptop, which in our experience was at least 20-times faster
than the manual processing in ImageJ and avoided the excessive eye
strain associated with the manual method. The only difference in the
output is that the manual ImageJ) method records a fraction of the flu-
orescent pixel area captured relative to the entire image area, while Ar-
eaPipe reports the actual number of fluorescent pixels captured from
an image out of the total pixel area in images. In order to allow these
data to be plotted on a log scale, when zero pixels were recorded, we
substituted a value of 5 pixels, and with the manual method, when
zero area was recorded, 0.0001 was substituted for the area, which

was close to the lowest values recorded experimentally.

5.7 | Quantitative inhibition and killing studies

Up to four types of assays were used in attempts to quantify Dec-
tiSome inhibition, killing, and/or survival after treatment with lipo-
somal AmB. (1) Cell density was recorded at A,,, nanometers in
96-well microtiter plates (BioTeK Synergy HT microplate reader). (2)
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Colony-forming units (CFUs) of C. neoformans were counted after plat-
ing dilutions of cells on YPD and incubating at 30°C. (3) Propidium
iodide staining of dead cells followed our previous published protocol
(Ambati, Ellis, et al., 2019). (4) CellTiter-Blue reagent (CTB, resazurin,
Promega Cat#G8081) was used to measure the reduction in live cell
metabolic redox activity, with 20 uL of reagent being added to 100
pL of cells in 96-well microtiter plates. After CTB was added, C. albi-
cans, R. delemar, and C. neoformans were respectively incubated for
approximately 1 h at 37°C, 2h at 37°C, and 18 to 24 h at 30°C before
the fluorescent product resorufin was measured at Ex485/Em590
(BioTek Synergy HT). We have not seen fluorescent CTB assays of C.
neoformans reported previously, but an XTT colorimetric redox assay
had been used previously (Martinez & Casadevall, 2007). Fluorescent
CTB assays have a much larger dynamic range than colorimetric XTT
assays. Long incubation times (e.g., 24 h) with CTB's resazurin dye are
commonly used to measure the viability of Mycobacterium spp. follow-
ing drug treatments (Amin et al., 2009; Franzblau et al., 1998).

5.8 | Data management

Data were recorded and managed in Excel (v. 16.69). The CellProfiler
AreaPipe output data were in the .csv file format, which is compat-
ible with Excel. Scatter bar plots were prepared, and standard errors
from the mean were estimated in GraphPad Prism 9 (v. 9.5.0). Most
of the data were normally distributed, so the Student's two-tailed
t-test was used to estimate p values (T.TEST in Excel). In cases where
the data for at least one sample in a comparison appeared to be non-
parametric in their distribution, p values were estimated using the
Mann-Whitney U test (Mann & Whitney, 1947) in Prism 9 and were

indicated as P, values.
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